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 Addendum No. 1 Transferring data from inclinometer loggers. 
 
Note: The simplest way to transfer data between Gtilt and Slope Indicator Company’s 
Digitilt® DataMate is to use the DMI utility, which is included on the Gtilt CD. A user 
manual for DMI is also included on the CD.
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1.  INTRODUCTION 
 
GTILT is designed to allow the user to analyze small and large volumes of inclinometer 
data with a minimum of effort. It is intended for use with a wide range of inclinometer 
probes, cables, casing, and loggers produced by manufacturers around the world. 
GTILT also supports keyboard input of manual readings. 
 
Use of this program is subject to the terms of the software license agreement. 
Technical support for GTILT is available from: 
 

Mitre Software Corporation   Phone: (780) 434-4452 
9636-51 Avenue, Suite 200  Alt: (866) 442-4691 
Edmonton, AB    Fax:     (780) 437-7125 
Canada T6E 6A5    info@mitresoftware.com 
      www.mitresoftware.com 

 
1.1 Features of Gtilt 
 
• The .GTL data file format is forward and backward compatible between GTILT 

versions 2 and 3 for Windows and with GTILT for DOS. 
 
• Each .GTL file contains all the readings for a single inclinometer. This makes it 

easier to provide inclinometer data to others for review, and does not bog down as 
the number of inclinometers in a folder increases. 

 
• A plot of the current file is visible as soon as an inclinometer is loaded, and remains 

visible when the program is running. 
 
• Wide range of plot types and diagnostic tools. 
 
• Compatible with a wide range of inclinometer equipment; imports many types of 

inclinometer data files directly, and comes with conversion utilities for others. 
 
• All plots are available in the inclinometer groove directions or at a skew angle. 
 
• Ready access to all readings using a three-dimensional editor. 
 
• Readings can be viewed either in raw form or as a change from a previous reading. 
 
• Checksums can be viewed in histogram form and/or as a plot against depth, 

allowing an immediate quantitative assessment of the quality of each dataset and 
detection of possible bias shifts. 
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• Supports probes of any base length 
 
• Plots in English or Metric units, independent of probe type 
 
• Top-down plots can incorporate independent surveys of surface movement 
 
• Stratigraphy, piles, tunnels, excavations, remarks etc. can be drawn directly on plots. 

This can help greatly with interpretation. 
 
• Datasets can be marked for inclusion on all plots, on no plots, or on time plots only. 

For plots vs depth or elevation, individual datasets can also be suppressed by 
clicking directly on the plot legend. 

 
• Crowded plots can be made clearer by cycling through the datasets, visualizing the 

buildup of a displacement pattern. 
 
• Technical support provided directly by program developer. 
 
• Inclinometer data evaluation service available on a consulting basis. 
 
 
Additional Features of Gtilt Plus: 
 
• Batch printing: specify the selection and order of inclinometers to be plotted, along 

with the desired plot types, and leave Gtilt Plus to do the rest. 
 
• Fast scrolling through multiple inclinometers: display any desired type of plot, then 

scroll rapidly through the corresponding plots for all the inclinometers on a list. This 
speeds comparison and interpretation, and is faster than turning pages in a report. 

 
• Extra plot type: Resultant Cumulative Displacement and Azimuth vs Depth or 

Elevation 
 
• Interactive application of corrections for bias shift and accelerometer rotation. 
 
• Corrections for settlement, cable stretch, and depth reference errors. 
 
• Correction for spiral using data from spiral probes of various types. 
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1.2  Installation 
 
The SETUP program will copy the required files to your hard disk and configure your 
system. 
 

1. Before installing GTILT®PLUS, it is recommended that you first close any 
other programs that may be running. Then insert the program CD.  

 Do not insert the security key yet. 
 

2. Place the program CD in your CD ROM drive. After a few seconds, the 
install program should start automatically. If it does not, select Start/Run… 
and navigate to the GTPLUS32 CD. Select the file setup.exe and run it. 
Follow the prompts to finish installing the software. 

 
3. You should normally also accept the installation of the Sentinel System 

Driver, which communicates with the security key. Sometimes this driver is 
already present and so may not need to be installed. The driver 
installation program is \Sentinel\setup.exe on the program CD. It is 
possible that administrator privileges may be required to install a system 
driver.  If you install the driver, it will be necessary to restart the computer 
in order for the driver installation to become effective and recognize the 
key. 

 
4. Wait until the computer has fully restarted, then insert the security key into 

one of the computer’s USB ports.  Start GTILT®PLUS. If the program 
does not recognize the key, try starting it once more before calling Mitre 
Software Tech support at 780-434-4452. 

 
 
1.3 How Inclinometers Work 
 
1.3.1 Introduction 
 
The general idea behind inclinometers is to provide a cost-effective way of monitoring 
lateral movements which may occur some distance below the ground surface. In order 
to minimize the cost of the system, simple and relatively inexpensive components 
(empty casings) are used for the permanent part of each monitoring installation. In 
general, the casings are surveyed or read using relatively sophisticated equipment 
which is placed in the casing only when readings are actually being taken. 
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A0 or A+ groove
(reference direction)

A180 groove

B0
groove

B180
groove

A typical installation consists of an aluminum or plastic casing fixed in position in a 
borehole by the use of grout, or, less frequently, by carefully tamped or vibrated sand 
backfill. 
 
The casing normally has four longitudinal grooves on its inside wall. The casing is 
generally supplied in 3 m or 10 ft lengths, and there is a system to ensure that the 
internal grooves line up from one piece of casing to the next. 
 
One pair of diametrically opposite grooves is referred to as the A grooves, while the 
other grooves are called the B grooves. The A0 or A+ groove is used as the reference 
direction and is often marked by cutting a small V-notch in the casing. The B0 or B+ 
groove is 90 degrees clockwise from A0, as shown in Figure 1. 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
Figure 1 Plan view of inclinometer casing showing groove directions. 
 
On projects with just a few inclinometers, the casing is usually installed such that one 
set of grooves points in the expected direction of movement. This pair is assigned to be 
the A0 and A180 grooves, usually with the A0 groove pointing in the direction towards 
which movement is expected. 
 
On large projects, the A0 groove is sometimes oriented to correspond to site North or 
other standard direction. This can be helpful in the interpretation of large quantities of 
inclinometer data. 
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Figure 2 An Inclinometer Probe 
 
The inclinometer probe itself (Figure 2) is a cylindrical instrument typically about 
800 mm long and about 25 mm diameter. Near each end it has a set of carefully-
machined spring-loaded wheels designed to center the probe in the casing, while the 
wheels run in the grooves. Modern probes are biaxial, that is, the probe contains two 
accelerometers which measure the inclination of the probe axis with respect to the 
vertical. The A accelerometer is aligned to measure inclinations in the plane of the 
wheels, while the B accelerometer measures in the plane at right angles to the wheels. 
The probe axis is common to both planes. In most systems, the numerical value of the 
output is proportional to the sine of the angle of inclination from the vertical. 

Toolface

Angle of Inclination
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If you are new to inclinometers, it is instructive to try out your system in the laboratory 
before taking any readings. Connect the probe, cable and readout together, rest the 
bottom (non-cable) end of the probe on the floor, and hold the probe vertical. Depending 
on the sensitivity, both the A and B readings should be relatively close to zero, say in 
the -100 to +100 range. The tool face direction is in the plane of the wheels, and may be 
indicated by the direction of the uppermost wheel or by a mark on the body of the 
instrument. If you keep the lower end of the instrument resting on the floor and move 
the upper end in the toolface direction so as to tilt the instrument, you should observe 
that the A reading becomes more positive, giving a reading of several thousand units for 
a tilt of 20 to 30 degrees. At the same time there should be relatively little change in the 
B reading. 
 
To take a set of readings in an actual casing, the probe is connected to the cable and 
readout and powered up. Its wheels are then aligned with the A groove, with the probe 
toolface direction pointing in the direction of the A0 groove. (The A0 groove is often 
identified by a small V-notch cut in the top of the casing.) The probe is carefully lowered 
down the casing, taking care not to bang it against the bottom. It is then held at the 
bottom reading point, normally just a short distance above the bottom of the casing, for 
five to ten minutes to ensure that the probe’s electronics have stabilized. The depth of 
the deepest reading is normally a multiple of one foot or half a meter, depending on the 
length of the probe wheelbase, which is usually either 2 ft or 0.5 m. Reading depths are 
determined from graduation marks on the suspension cable, usually with reference to 
the top of the casing. It is very important that all datasets use the same reference point. 
Inconsistent reference points are the most common cause of inaccurate readings. The 
reading of both A and B sensors is recorded either manually or by pressing a button on 
the logger. The probe is then raised by one probe wheelbase length (typically either 
0.5 m or 2 ft) and the next reading taken. The process continues until the probe reaches 
the shallowest reading position, which is usually taken as when the upper wheels are at 
about ground surface level. 
 
The probe is then removed from the casing and turned 180 degrees about a vertical 
axis so that the toolface points in the A180 direction. The probe is lowered again, using 
the same set of grooves as before but in the other direction, and the A180 and B180 
readings are taken. Note that for biaxial probes the B grooves are not used. 
 
 
1.3.2 Calculations 
 
An estimate of the deviation of the casing from true vertical in the plane of the A 
grooves could be calculated by plotting the cumulative sum of the A0 readings times a 
scale factor which takes account of the instrument sensitivity and the wheelbase of the 
instrument. This is usually done starting at the bottom of the casing, which is typically 
beyond the depth of expected movement and is generally assumed to be fixed. 
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A much better estimate can be made by using instead half the algebraic difference 
between the A0 and the A180 readings (A0 reading minus the A180 reading), as this 
reduces the influence of small zeroing errors in the inclination measurement. This is 
how the Absolute Position (AP) plot is created. AP plots are described in section 1.4 
 
Usually the casing is installed as close to vertical as possible and the exact amount of 
its small deviation from the vertical is of little interest. More often, it is the change in 
position of the casing during the time interval between surveys that is most important. 
This means that:- 
 

The most important information is related to the change in the difference between 
the A0 and the A180 readings with the passage of time. 

 
Changes in position (i.e. movements) cannot be plotted until at least two sets of 
readings have been taken. In most circumstances, these two readings would be 
taken on different dates, often weeks or months apart. 

 
A poor initial set of readings will impair accuracy or at least confuse the 
interpretation of any subsequent set of readings. 

 
Only displacements which occur after the initial set of readings has been taken 
can be reflected on any of the plots. 

 
 
 
1.4 Interpretation 
 
1.4.1 Cumulative Displacement (CD) Plots 
 
The most commonly-used type of plot for assessing the amount and location of any 
displacement that has occurred since the initial set of readings is the Cumulative 
Displacement (CD) plot. Assuming a perfectly-operating system, this plot shows the 
change in position of the casing since the initial set of readings. The author believes that 
this is the most useful type of plot, although it is sensitive to small errors which 
inevitably occur from time to time in the measuring system. In particular, this plot 
becomes sensitive to the precise alignment of the accelerometers if the casing has a 
significant deviation from the vertical. This is treated in more detail in Chapter 6. For CD 
plots, a gradual deviation from the centerline is usually considered less significant than 
a sudden deviation which occurs over a span of a few readings. 
 
 
1.4.2 Incremental Displacement (ID) Plots 
 
Another widely-used presentation is the Incremental Displacement (ID) plot, which 
shows the displacement over each probe length during the period since the initial 
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reading. It amounts to the first differential of the CD plot with respect to depth. This plot 
has the advantage of being relatively insensitive to instrument and operator problems, 
as errors do not get a chance to accumulate. Part of its usefulness is that it tends to 
highlight the reading positions at which real displacements are occurring. However, the 
true magnitude of the displacement is better judged on the Cumulative Displacement 
plot and then summarized on the Displacement/Time plot, which is described in section 
1.4.4. 
 
 
1.4.3 Absolute Position (AP) Plots 
 
This type of plot shows the actual shape of the inclinometer casing. The shape of the 
plot is determined mainly by how the hole was drilled. It is not generally useful for 
picking up movements but it can come in handy in assessing whether errors have been 
aggravated by a significantly non-vertical casing. AP plots are seldom presented as part 
of a normal report on inclinometer results. 
 
1.4.4 Displacement/Time (DT) Plots 
 
GTILT allows you to define the upper and lower limits of a depth interval which 
encompasses a shear zone. It then creates a plot of the change in position of the 
shallower point relative to the deeper one, against time. This provides a plot of the 
shear movement across the shear zone, while maximizing accuracy by making use only 
of the readings taken in the depth interval where the movement is occurring. 
 
Up to three pairs of depths can be selected and shown in a single plot. DT plots are 
most useful when an installation has been monitored many times and the trend of its 
behavior is important. Changes in slope of DT plots can often be related to rainstorms 
and seasonal factors. 
 
1.4.5 Shear Strain/Time (SST) Plots 
 
These plots are similar to DT plots, except that the displacements are expressed as a 
percentage of the vertical depth interval. This makes the plotted values sensitive to the 
thickness assigned to the shear zone. 
 
1.4.6 Rate Plots 
 
Rate plots are rarely used, as they tend to behave erratically unless the data is of very 
high quality. Displacement Rate plots and Shear Strain Rate plots are available, 
expressed as rate of change of displacement or shear strain per day or per year. Rate 
plots do not appear directly in the Plot Type menu, but are selected under 
Set/Preferences as a variation on DT and SST plots. 
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2.0 GETTING ACQUAINTED WITH GTILT 
 
2.1 Viewing and Plotting a Sample File 
 
This section guides you through loading and viewing sample data for an existing  
inclinometer. Start by loading the supplied sample data file SAMPLE1.GTL. This file 
contains readings taken from an inclinometer installed in 1988 adjacent to a tied-back 
retaining-wall next to the portal for an urban light rail transit tunnel. 
 
Choose File/Load and then the file SAMPLE1, which is in the program directory. Under 
Windows 95 this will usually be C:\Program Files\GTILT. Once the file has finished 
loading, a plot of cumulative displacement versus depth is displayed on the screen. This 
is the most widely-used type of plot. 

 
 
You can view a different plot by choosing it from the PlotType menu. The default plot 
type is the first on the list, Cumulative Displacement A and B. 
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2.2 Main Header 
 
Choose Edit/Main Header to view the main header data for SAMPLE1.GTL. The 
Installation No., Client, and Project appear on the plots as entered here. The functions 
of the other fields are described below. 
 

 
 
 
Readings depth interval defines the depth interval between individual readings in the 
same dataset and is normally equal to the length of the probe wheelbase. It also reflects 
the units system used for the depth marks on the cable, and will usually contain an entry 
such as “0.5 m” or “2 ft”. There should be no reason to change the depth interval once it 
has been fixed for a particular inclinometer. Once you take an initial set of readings at a 
0.5 m depth interval, for example, you are essentially committed to using a 0.5 m probe 
for the life of the inclinometer. (A changeover is not impossible, but the required 
procedures are very complex, and involve duplicate readings with two different probe 
types.)  
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Figure 3 
Important dimensions for completing the Main Header 
 
 
Shallowest Reading Depth is the depth of the shallowest reading as determined using 
the depth marks on the cable, assumed to be in the same units as the probe type. Thus, 
if you have a metric probe, you supply the Shallowest Reading depth in meters. This 
means that the depth of each individual reading can be described directly by the cable 
marks without any conversion of units, regardless of the units used in plotting. 
 
Stickup is the distance, measured along the inclinometer cable, from the reference 
elevation to the reference point used for reading the depth marks on the cable (See 
Figure 3).  In most cases the reference elevation will be the ground surface and the 
cable depth marks will be read by reference to the top of the inclinometer casing. This 
means that the Stickup will be equal to the distance that the casing sticks up above the 
ground surface. Stickup must be given in the same units as the Readings depth interval 
and the cable marks. 

Depth to shallowest
reading as per cable marks

Stickup (in meters for a metric probe)

Ground Surface or
other suitable
reference elevation

Read cable marks at top of casing
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A direction

B direction

X direction

Y direction

Ske
w Angle

(varies depending on skew angle)

 
No. of Readings is the number of locations in the casing at which readings are taken. 
Each location is assumed to be separated from its neighbors by the Readings depth 
interval. 
 
Output in English or Metric Units requires an entry of M or E to indicate Metric or 
English units. You can toggle between Metric and English units as desired. Note that 
the values for Stickup and Shallowest Reading Depth remain in the same units as the 
Readings depth interval. 
 
Reference Elevation is normally taken as the elevation of the ground surface. It can be 
in either feet or meters, but the units should be shown. If the units are not shown, the 
reference elevation is assumed to be in the same units as the output. Supplying the 
units explicitly will help avoid having the stratigraphy disappear off the plot when you 
change output units. 
 
Skew Angle is the direction of the X direction measured in degrees clockwise from the 
A0 direction. The X and Y directions, defined as shown in Figure 4, allow rotation of 
axes in order to handle situations where the casing grooves do not coincide with the 
principal directions of interest. A non-zero value in this data field leads to a doubling of 
the number of plot type choices presented in the Plot Types menu. 
 
 
 
 

    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 4 
Definition of Skew Angle and X and Y directions 
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Probe Sensitivity is very important. It represents the integer that would be input to 
GTILT to represent a reading taken in the A direction with the probe tilted 30 degrees 
towards the A0 direction. For a readout which shows twice the sine of the angle of 
inclination to four decimal places (typical for many 2 ft probes) the number 10000 
should be entered here. Some metric probes give an output of 2.5 times the sine of the 
angle to four decimal places and therefore require the number 12500.There are also 
some probes which use 2.5 times the sine to three decimal places. These would have a 
probe sensitivity number of 1250. It is imperative that you double-check the results 
given by GTILT using the manual calculation method prescribed by the instrument 
supplier until you are sure that you are using the correct sensitivity value. If you are in 
any doubt about the value to be used for probe sensitivity, contact your instrument 
supplier. Most manufacturers are familiar with GTILT and will be able to supply the 
required number. 
 
2.3 Subheader 
 
When you choose Edit/Subheaders, the subheader screen for the latest dataset 
appears: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The right side of this window controls functions specific to Gtilt Plus and so may not be 
present. Most of the data fields shown are optional but it is suggested that they be filled 
in to assist in recordkeeping. The only indispensable piece of data is the Reading Date. 
The Start Time (default = 1200) is useful not only for installations which are monitored at 
very frequent intervals, but also for some types of detailed interpretation. If most or all of 
the data fields are filled in, it will make it easier to track down the source of any poor 
quality data that may be generated. In particular, note that items such as reading start 
time, probe used, and the remarks field are carried over to the Database menu, where 
they may help you in identifying a particular dataset. 
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You can view all subheaders for the current inclinometer using the command buttons or 
the horizontal scroll bar at the base of the window. You could also use Ctrl-Left and Ctrl-
Right, or use Alt-P for the previous and Alt-N for the next dataset. 
 
2.4 Readings 
 
When first opened, the readings editor shows the latest set of readings taken on the 
inclinometer and presents them for editing. You can navigate through the dataset using 
PgUp, PgDn Tab, Shift-Tab and the cursor keys. Only integer numbers from  
-30000 to +30000 are permitted. 
 
 Note that as you browse through the data, a dumbbell simultaneously appears on the 
current plot. This allows you to see how the plot is influenced by each line of data. You 
may want to move the readings editor window off to the right of the screen so as to get 
a better view. The dumbbell not only indicates which part of the plot is affected by a 
given line of data, it also lists the depth interval in terms of depth and elevation. 
 
The dataset date is reflected by a rectangle bracketing the legend for that dataset.  You 
will probably need to move the readings editor window aside in order to see this. 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The Readings Editor 
 
The plots on the right side of the readings editor window show how the A and B 
checksums vary with depth. An indicator bar on the checksum plot shows how features 
on the checksum plot relate to the tabulated data. The corresponding exact checksum 
value appears beside the indicator bar. You can reposition the bar directly by clicking on 
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the checksum plot. The focus then moves to the corresponding raw numbers in the 
table.  If you edit the raw data, the checksum plot will immediately reflect the change. 
 
In the event that you have, say, ten sets of readings in memory, but only sets 1,4,6,7 
and 8 are selected for plotting (i.e. have an asterisk or a T against them in the Database 
Menu) then the readings editor will skip over the sets which are not selected for plotting. 
In the example quoted above, this means that three presses of Alt-P will switch the 
screen from set 8 to set 7 to set 6 to set 4. The benefits of this approach become very 
clear when you have twenty or thirty sets in memory and are interested in only three or 
four of them. You can override the skip by checking the box marked “Show All sets”. 
 
As an alternative to displaying the actual readings, you can display a histogram of 
checksums for either the A readings or the B readings in each dataset. The choice of 
display is made using the three option buttons in the lower-middle of the window. 
A quick test for consistency of the data set is to check that the readings histogram 
clusters tightly around a particular checksum (the "Modern City" look). If your histogram 
suffers from "Urban Sprawl", especially if there are a few Suburbs there may be some 
data errors. The B readings usually show a wider range of checksums as the orientation 
of the probe is less precise in this direction. When you switch back to the readings 
display, the cursor will highlight the individual A reading whose checksum lies farthest 
from the mean for all the A readings. If a reading error exists, this stands a good chance 
of being its source. 
 
When a particular reading in the table has the focus, a copy of the corresponding value 
in the previous set of readings is displayed on the right of the window. This is useful in 
spotting gross errors in data input.  
 
2.4.1 Change from Previous 
 
Sometimes it is useful to view the numbers in terms of their change from the previous 
dataset. This can be activated by clicking on the option button labeled “change from 
previous”. While this option is active, the table is shown with a yellow background. The 
display reverts to the raw readings if no earlier flagged dataset is available. 
 
It is also possible to display the change from the original dataset, also on a yellow 
background. Note that if you display the initial dataset in this format, all values in the 
table will be zero. 
 
Along with the yellow background, the median change is shown at the base of each 
data column. The median is shown in preference to the mean as it is insensitive to 
occasional extreme values and better represents instrument performance. 
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2.5  Plot Types 
 
Under the Plot Types menu, the A and B selections (the first nine options) represent 
displacements in the plane of the A and B grooves. The lower half of the menu refers to 
the X and Y directions and is displayed only if a non-zero Skew Angle is shown in the 
Main Header. The plot which displays when you first load an inclinometer corresponds 
to the first option, Cumulative Displacement in the A and B directions. 
 
2.5.1 Plots vs Depth or Elevation 
 
The first five plot types show displacements versus depth or elevation. The depth scale 
shown represents the depth below the reference elevation, usually taken as the ground 
surface. By default, the vertical scale is displayed in terms of depth. You can display 
elevations instead of depths by setting the appropriate option under Set/Preferences. 
 
The vertical and horizontal scale ranges are selected automatically but you can override 
them by entering the desired limits directly on the axis, in the boxes provided. Once you 
have entered the new ordinate value, press Tab to implement the change. The vertical 
scale limits are always entered in terms of depth limits, even when the adjacent scale is 
labeled in terms of elevations. 
 
2.5.2 Plots vs Time 
 
To change the vertical scale of plots vs time, enter the desired limits directly on the 
vertical axis in the boxes provided, and shift the focus away by pressing Tab. Note that 
negative entries are permitted. 
 
To change the time scale of the current plot, enter new start and end dates on the 
horizontal axis, and press Tab. 
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2.6 Printing Plots 
 
 
To make a printout of a particular plot, first display it on the screen and adjust the scales 
to your liking. Then choose File/Print Graphics. You can choose a printer, and specify 
Portrait or Landscape orientation. The paper size is determined by the default properties 
set in Windows for the particular printer selected. You can adjust plot line thicknesses 
under Set/Line Widths. 
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3.0  ENTERING YOUR OWN DATA 
 
To enter your own inclinometer data, restart the program or select File/New. It is a good 
idea at this point to plan where you will be storing your data on disk. It is recommended 
that you create a separate folder for each group of inclinometers, so that a given folder 
might represent a project or an area within a large project. 
 
If you are not using an automatic logging device, but will be entering the data by hand, 
select Edit/Main Header and fill in the form. Most important are the selection of 
Readings depth interval (usually either 2 ft or  0.5 m) and the sensitivity, which is 
expressed as the integer which will be input to GTILT to represent a 30-degree tilt. The 
casing stickup and the depth of the shallowest reading are also needed if the graphs are 
to show the correct depths. 
 
3.1 The Initial Set of Readings 
 
To enter the initial set of readings manually, select Edit/Subheader, and fill in the 
subheader screen for the first set of readings. It is particularly important to fill in the 
correct date. Select the Readings command button to get into the readings editor and 
enter the readings as integers. 
 
If you are using an inclinometer logger, transfer the data from the logger using the 
TiltComm utility, which is launched from the File menu. If you are using Slope Indicator 
Company’s DataMate, it is suggested you transfer data using the DMI utility, which is 
provided with GTILT. Use of TiltComm with various loggers is described in Addendum 
No. 1 at the back of this manual. 
 
Once the data has been transferred from the logger, import the first dataset by selecting 
File/Import and then the appropriate file format. The first time you do this, you will have 
to navigate to the appropriate directory. The next time you run GTILT, the same 
directory will be presented as the default for importing this particular format. 
 
Once you have entered or imported a full set of readings, you can use the option 
buttons in the lower right to display Histogram A. Examine the checksum histogram to 
see which A reading has the most extreme checksum. This should not be hard to find 
as the cursor will automatically point to it when the spreadsheet returns. Check and edit 
the reading as necessary. Recheck the A histogram until you are satisfied that no 
further gross errors exist, and repeat with Histogram B. No Cumulative Displacement 
plot is displayed yet because all plot types other than Absolute Position require at least 
two datasets.  
 
Another, perhaps even better way to evaluate the data quality is by using the checksum 
plots on the right side of the readings editor window. If you have been typing in the data 
or done some editing, close and reopen the data editor window to ensure that the 
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checksum plot is up to date. If you have more than one dataset, you can do this by 
switching to another dataset and back again. The checksum plot should show a value 
which remains fairly constant with depth.  
 
For probe sensitivities in the range of 10000 to 12500, the mean checksum is usually in 
the range of -50 to +50, with a standard deviation of about 5 for the A direction and 10 
for the B direction. Significantly larger standard deviations may be caused by a faulty 
probe or by problems with the reading procedure. They can also be caused by local 
distortion of the casing.  A mean checksum outside the range of -50 to +50 is often 
taken to suggest than the probe should be overhauled and recalibrated. However, much 
larger checksums can be tolerated without significant loss of accuracy. The main 
disadvantage to a checksum of, say, 100 is that it tends to disrupt the usual pattern of 
plus and minus signs in the columns of data and thus tends to lead to more transcription 
errors if the numbers are being recorded manually.  
 
Select File/Save As and navigate to the directory where the data is to be stored. Supply 
a filename, and click OK to write the file. The filename extension GTL is used by default.  
 
 
 
3.2 Subsequent Sets of Readings 
 
Before entering or importing any new data, first use File/Load to load the appropriate 
GTL file into GTILT. This is not necessary if you have just written the GTL file as 
described above. 
 
To add a set of data manually, choose Edit/Readings and select Add New Set. Fill in the 
subheader data for the new set, and select Close when finished. Then enter the 
readings in the readings editor, check for errors using the histograms, and select Close. 
If you are using a logger, import the second set of data in the same way as the first. At 
this point, the default plot type, Cumulative Displacement in the A and B directions, will 
display automatically. 
 
Since you have already provided a path and filename when you saved the first dataset, 
you can incorporate the new data into the existing GTL file simply by using File/Save. 
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4.0  REFERENCE LIST OF MENU FUNCTIONS 
 
4.1 File Menu 
 
File/New  
 
File/New allows all data to be cleared from GTILT without restarting the program. If 
significant changes have been made to the current inclinometer, you are given the 
opportunity to save the changes before continuing.  
 
File/Load... 
 
File/Load... is used to load a GTL file from disk. A GTL file can contain all the datasets 
associated with a particular inclinometer. When a GTL file is loaded, information on the 
number of datasets and the number of readings in each dataset is displayed at the base 
of the window. 
 
File/Combine... 
 
File/Combine... is used infrequently. It is most useful when two separate parties such as 
a contractor and a consultant have acquired readings for the same inclinometer, or in 
any situation where you end up with two GTL files, neither of which contains all datasets 
for a given inclinometer. To combine the files, you first load one file using File/Load, and 
then combine this with the other file, using File/Combine. The two files must have the 
same number of readings, i.e. the same number of depth intervals. As the second file is 
read from disk, a check is made on each dataset to see if it is already represented in the 
first file. This is done by checking the date and start time for each dataset. Once you 
have combined the second file, you can simply use File/Save to write a file which 
contains all datasets from both files without duplication. 
 
File/Save 
 
File/Save is the most commonly-used method of saving a file to disk. It simply uses the 
same name as when the file was loaded from disk, thereby overwriting the original file. 
 
File/Save As... 
 
File/Save As... works in the same way as File/Save except that it provides an 
opportunity to change the filename. In most situations the File/Save option is simpler, 
see above. 
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Before writing to disk, a check is made to ensure that the data sets are in chronological 
order. If any sets are found to be out of order, the user is offered the option to have 
them rearranged: 
 

Readings not in chronological order 
Do you wish to sort file while writing to disk? 

 
Do not approve the sort unless you are sure that the dates shown for each set of 
readings are correct and you know why the sets are out of order. Approving the sort has 
no immediate effect on the loaded data, but it does change the order of the sets in the 
file on disk. If you need to use the reordered data, use File/Load to reload the file. You 
will now find it easy to check for superfluous duplicate sets of readings and mark them 
for deletion as they will now be neighbors in the database list. Save the file once more 
to make your deletions permanent. 
 
 
File/Import... 
 
This leads to a submenu on which you can choose the type of data to be imported. Most 
of the formats supported store one dataset in each file, and normally you should load 
the appropriate .GTL file before importing any additional data. 
 
 
File/Print Graphics... 
 
This prints the currently displayed plot. 
 
 
File/Tabulate... 
 
This raises a submenu with various options for printing out raw data, processed data, 
checksums, and plotted coordinates. Note that sets not selected for plotting will be 
excluded, allowing you to choose to print any combination of reading sets. The output is 
written to a file called GTILT.OUT, which is then displayed in a simple viewer and made 
available for printing or copying to the Clipboard. Depending on your presentation 
needs, you may want to paste the text into a word processor before printing it. It is 
suggested that you use a monospaced font such as Courier in order to make the 
tabulation columns line up. 
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File/Exit 
 
File/Exit ends the current session of GTILT. If you have done any editing to the current 
file or you wish to record changes to the default horizontal scales or the depth intervals 
for Time/Displacement plots, be sure to Save your file to disk before leaving GTILT. 
 
4.2 The Set Menu 
 
Set/Preferences 
 
Set/Preferences allows you to specify whether the top or bottom of the casing should be 
assumed to be fixed, whether the plots should be labeled with depths or elevations, 
whether plots against time should show displacement or rate of displacement per year 
or per day, and whether plot symbols should appear at each plotted point. 
 
Set/Left and Right Plots, Left Plot only, Right Plot only 
 
Set/Left and Right Plots specifies that plots versus depth or elevation should have two 
graphs per page, and is the default setting. The following two selections, Set/Left Plot 
only and Set/Right Plot only, allow you to create wider plots by placing only one plot per 
page. 
 
Set/Hard Copy Plot Layout 
 
Set/Hard Copy Plot Layout allows you to edit the main dimensions used in setting up 
plots, thereby giving you control over the appearance of the plots. 
 
Set/Spiral Correction 
 
Set/Spiral Correction appears only in GTILT PLUS. This turns on spiral corrections, 
provided spiral data is present in the current data file. If the spiral array is empty, a 
message appears and no correction is applied. 
 
Set/Depth Corrections 
 
Set/Depth Corrections is usually used with telescoping casing and appears only in 
GTILT PLUS. It tells the program to look for depth correction/settlement information and 
to modify readings accordingly. Because this process modifies the actual readings, it is 
recommended that the file be saved before the modifications are made, and that the 
resulting changes be abandoned without saving. This allows the original readings to be 
preserved. 
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4.3 The PlotType Menu 
 
The Plot Type menu specifies which type of plot should be displayed on the screen.  
Note that if you have only one dataset, all plots except for Absolute Position will be 
blank. The various types of plots are described in Section 1.4. 
 
 
4.4 The Edit Menu 
 
 
Edit/Readings... 
 
Edit/Readings... displays a window which is used to view raw inclinometer data and 
check its consistency by using checksum histograms. It also lets you key in additional 
datasets or extend the casing by joining additional lengths of casing on to the top of the 
inclinometer. 
 
 
Edit/Subheaders... 
 
Edit/Subheaders... displays information on each individual dataset and allows it to be 
edited. The most important piece of information is the reading date. The subheader is 
also used to record details of the equipment used on a particular occasion. In GTILT 
PLUS, certain fields are also used to record casing settlement and various types of 
probe correction. 
 
 
Edit/Main Header... 
 
Edit/Main Header... displays header information such as the installation number, client, 
project, location, and so on. 
 
 
Edit/Scales... 
 
Edit/Scales... shows the current full-scale values for CD, ID, and AP plots. The lower 
part of the window shows up to three depth intervals which define the shear zones to be 
used in plots versus time. The boundaries of each depth interval are rounded by the 
program to the nearest reading depth. If the depth intervals are left blank, the 
corresponding plot is omitted. 
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Edit/Stratigraphy... 
 
Edit/Stratigraphy... displays a table showing the attributes of the lines and text which 
have been drawn on the screen. The meanings of the various parameters shown in the 
stratigraphy table are as follows: 
 
 
X1, Y1 Coordinates of the start of a string of text or the first point on a line which 

has been drawn on the plot using the Draw menu. The X coordinate has a 
value of zero on the left side of the left plot, and 100 on the right side of 
the first plot. The Y coordinate is normally expressed in terms of elevation. 

 
X2, Y2 Coordinates of the second point on a line. Not used for text entries. 
 
P  This controls the placement of the line or text. An entry of L, R, or blank 

causes the line or text to appear on the left plot only, the right plot only, or 
both plots. Lines appear on both plots by default. If you want a line to 
appear only on the left plot, for example, draw it on the left plot, and then 
enter an L for its Placement value. If you want it to appear only on the right 
plot, you should still draw it on the left plot, but enter an R for the 
Placement value. 

 
If you draw text below the base of the plots, it will be assigned a P value of 
A, B, X, or Y. This causes the entry to appear only in association with plots 
in the A, B, X or Y directions, making it ideal for direction labels such as 
North, Downhill, Towards the river etc. This type of Placement uses a 
different definition of the Y coordinate, so that the position on the page is 
not affected by changes in the vertical scale. In this case, the Y coordinate 
is defined in terms of distance from the bottom of the page. This normally 
assumes a page height of 2600 units. 

 
Size  The size of text in points. The default value is 10 point. 
 
Color  The color of the line or text. The number refers to the number of the plot 

colors which are accessed under Manage/Choose Colors. For example, if 
the default colors are used, an entry of 15 will give blue text. The color 
defaults to black. 

 
Text  The text string to be shown on the plot. 
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4.5 The Manage Menu 
 
Manage/Database... 
 
Manage/Database... brings up a window listing all datasets for the current inclinometer. 
It lists their date, time, selection attributes, and reproduces the upper remarks field for 
each set. This window is used to control which datasets appear on the plots, and 
becomes important in controlling clutter once several datasets have been accumulated. 
The significance of the various attributes is as follows: 
 

*  this set appears on all plots 
T this set appears only on plots versus time 
A this set is flagged for averaging 
a this set has already been used for averaging 
D this set is flagged for deletion 

 
You can change the attribute by clicking on a cell or by shifting the focus to the 
appropriate cell and pressing the spacebar. 
 
If you mark two or more plots with the attribute A, and then close and reopen the 
window, you will find that the A attribute has changed to lower case, and an extra set 
has been inserted following the last marked plot. The readings contained in the extra set 
are calculated as the average of the corresponding readings in the marked sets. By 
flagging just one set for averaging, a duplicate dataset can be created. 
 
To delete a dataset, you flag it with the attribute D. The next time the file in RAM is 
saved, it will be omitted from the file written to disk. It will of course remain in RAM, with 
its D flag, until the file is read back from the disk. Until then it can be recovered by 
flagging with a different attribute. If you do this, remember to save it to disk again also. 
 
Manage/Update Flags 
 
Note that Manage/Database is not the only place where you can specify which datasets 
appear on plots; you can also suppress datasets from appearing on plots against depth 
simply by clicking on the corresponding plot symbols in the legend in the center of the 
screen. The most common reason for suppressing such datasets is to reduce crowding 
on the plot, and this method lets you see immediately the effect of omitting a particular 
dataset. You can redisplay the set by clicking again on the spot in the legend where the 
symbols normally appear. Once you are satisfied with the appearance of the plot, 
choose Manage/Update flags to transfer your selection to the Database screen. Plots 
deselected in this way have their attribute changed from * to T, so that they still appear 
on plots versus time. They can of course be suppressed completely by blanking the T 
attribute in the Database screen. If you click on the words “initial set”, this suppresses 
all sets except the initial one. The missing sets can be redisplayed one by one by 
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clicking the appropriate point on the legend. They can be redisplayed all at once by 
reselecting the plot type. 
 
Manage/Choose Colors 
 
Here you specify the colors to be used for plotting. Two sets of color choices are 
provided, default.col and black.col. You can also make up your own set of colors and 
save it to disk under a name of your own choosing. 
 
4.6 The Draw Menu 
 
The Draw menu is used to annotate plots to show such items as stratigraphy, piles, 
tunnels, and excavations. 
 
Draw/Line 
 
Draw/Line is used to draw a single line using the mouse. Just click on the desired start 
and end points of the line. 
 
Draw/Polyline 
 
Draw/Polyline draws several connected lines using successive clicks. Use the right 
mouse button when completing the final line segment. 
 
Draw/Text 
 
Draw/Text places one or more strings of text on the plot. Click where the text is to begin, 
and the words “Text to be edited” appear. Type the text you want to appear on the plot, 
and press ENTER when done. You can change the size and color of each text string by 
using Edit/Stratigraphy, which is described in section 4.4. 
 
4.7 The Help Menu 
 
Help/About displays version information about GTILT and contact information showing 
where you can call for technical support. When you phone for support, try to be seated 
at your computer, with the software running. 
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5.0 ENHANCING ACCURACY 
 
Although not directly related to the functioning of GTILT, the following tips are offered to 
help new inclinometer users achieve satisfactory results: 
 
 Try to install the casing as close to vertical as possible. This reduces the effects 

of calibration changes which may affect the probe during the time interval 
between readings. Even more important, it minimizes the effects of 
accelerometer rotation errors. 

 
Minimize rough handling of the probe, especially when turning it around for the 
second pass, or when lowering it to the bottom for the second pass. Once you 
have started to take readings in a casing, do not power down the probe until the 
survey is complete. 

 
If you have more than one inclinometer probe, try to schedule readings such that 
the same probe is used for all sets of readings in a particular casing. You may 
wish to use the same probe for all jobs in a given geographic area, if they tend to 
be read during the same trip. 

 
Be very sure always to read the cable depth marks relative to the same point 
(usually the top of the casing). Using the wrong depth reference is a very 
common cause of errors. 

 
Avoid an extra site visit by making sure to use the correct pair of grooves. Since 
marks on casing can wear off, mark the A0 groove by cutting a notch in it.  

 
For best results, use the same cable or at least keep track of which cable you are 
using on each occasion. 

 
Do not forget to allow the instrument to warm up after it has been lowered to the 
bottom of the casing, before taking any readings. 

 
The very best results are achieved when the same technician is used for all 
datasets. 

 
When installing a new inclinometer, try to allow at least a few days for the grout 
to set up and the casing to stabilize in the hole before taking the initial readings. 
Take two initial sets and compare them on a CD plot. This helps avoid errors in 
the critical initial set. 
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If you use a probe with 2 ft wheelbase, it is usually better to read at 2, 4, 6 ft 
depth etc. than at 1, 3, 5 ft etc. This applies if the cable marks show the distance 
from the center of the probe, you are measuring depths from the top of casing, 
and all the casing is in 10 ft lengths. The reason for this is that it makes it far less 
likely that readings will be taken with the wheels on casing joints. If the top piece 
of casing is 5 ft long, and all the others are 10 ft long, it follows that reading at 1, 
3, 5 ft etc. will be preferable.
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6.0 ADDITIONAL FEATURES OF GTILT PLUS 
 
6.1 Introduction 
 
GTILT PLUS has a number of additional features designed specifically for advanced 
inclinometer users. The main extra features are as follows:- 
 
(a) Correction for spiral of the casing grooves, i.e. where the azimuth of the grooves 

varies with depth. 
 
(b) Correction for accelerometer rotation error, which is often associated with 

casings which are out of vertical or casings surveyed with multiple probes or with 
probes subjected to rough handling. 

 
(c) Correction for zero shift , also called bias shift, an error which is usually caused 

by rough handling during the course of taking readings. 
 
(d) Correction for casing compression error, where the casing has telescoping joints 

designed to handle compression and settlement of the surrounding ground, as 
could occur in a landfill or a very high embankment. 

 
Some of the correction types listed above are useful for correcting error types for which 
they were not specifically designed. A number of these applications are described 
below. 
 
6.2 Casing Spiral 
 
Most inclinometer casings are installed with grooves which are maintained at a constant 
azimuth from the top to the bottom of the casing. Exceptions to this can occur if the 
casing is extremely long (>60 m or so), or if lengths of plastic casing were allowed to 
heat up in the sun and subsequently twisted or warped prior to installation. It might also 
be possible to have a bad batch of casing, which could have a built-in spiral of some 
fraction of a degree per joint. Most casing specifications now specify that the casing 
twist may not exceed 0.1 degree per 3 m length. 
 
Sometimes during installation, there is a temptation to twist the casing in the hole. If 
there is any slack in the jointing system, this action will tend to accumulate the slack at 
all joints in the same direction, leading to some degree of spiral in the hole. The casing 
also has only limited torsional stiffness, so in a deep hole filled with grout, a casing 
which was twisted during installation could twist elastically and not fully recover. The 
resulting spiral would be locked in when the grout set up. 
 
In spite of all the above possibilities, most casings less than 60 m deep probably end up 
with less than about 5 degrees of spiral, which is about the same order of accuracy to 
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which the alignment of the A0 groove at the surface is recorded in the first place, so that 
corrections for casing spiral are not normally required. 
 
6.2.1 Correcting for Casing Spiral 
 
Casing spiral is conveniently expressed in terms of the total number of degrees of 
change in azimuth of the A0 groove, relative to the azimuth of the A0 groove at the top 
of the casing. This is also referred to as the number of degrees of cumulative twist, 
measured clockwise downwards from the top of casing. 
 
If you know how much your casing twists with depth, you can enter this information 
manually into GTILT PLUS. Choose Edit/Spiral Data and enter the cumulative casing 
twist value directly for every reading depth.  
 
You may not have spiral values for every inclinometer reading depth, as the spiral probe 
is usually longer than the inclinometer probe. If this is the case, just enter the spiral 
values you do know, and leave the rest as zero values. Then choose Interpolate. The 
interpolation assumes that spiral at the 
shallowest reading is zero, and treats 
zero values as blank. If you have 
calculated that the spiral is actually 
zero at some other depth, enter that 
value as 0.001 degrees so that the 
interpolation routine will treat it 
correctly. 
 
For example, if you know that the spiral 
(cumulative twist) is 10 degrees at the 
bottom of the casing, and you have no 
other information about spiral, you 
could enter 10 degrees for the spiral at 
the lowest inclinometer reading and 
leave all the other entries blank. If you 
then choose Interpolate, all the 
intermediate values will be filled in 
automatically. 
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You could then choose whether or not to apply spiral corrections under Set/Spiral 
Correction. Information on casing spiral is most commonly obtained by using a spiral 
tool, which is inserted into the casing in the same way as the inclinometer probe. Spiral 
tools are commonly rented, not purchased, because the tool is so rarely required. Also, 
no more than one spiral reading would normally be taken on any inclinometer, as the 
casing twist is not likely to change with the passage of time. 
 
6.2.2 The GSPIRAL Utility 
 
GSPIRAL is a DOS-based utility program which is supplied with GTILT PLUS. It has 
options for printing plots and tabulations, but these support only certain printer types, 
which must be connected to the machine’s first parallel port. However, GSPIRAL’S 
essential functions do not require printing.  The GSPIRAL program is designed to make 
it easier to use readings originating from a spiral survey tool such as the Slope Indicator 
Company Spiral Sensor Model 50901, or the IC4000 spiral tool from RST Instruments.  
You can of course calculate the cumulative twist values manually and enter them into 
GTILT PLUS as described in section 6.2.1, without using GSPIRAL.  
 
If you are using a magnetometer- or gyro 
 
Spiral measurements are not necessary in the majority of cases; however, they should 
be considered for any installation over 100m deep or when there is some reason to 
suspect a problem with spiral. 
 
GSPIRAL’S main features are as follows:- 
 
(a) GSPIRAL calculates, plots and tabulates spiral of casing grooves versus depth. It 

does not calculate displacements. Once the user is satisfied that he has input the 
data correctly, he can use GSPIRAL to create an .SPI file to hold the original 
readings and to provide a source of spiral data for GTILT PLUS. 

 
(b) If you are not using an incremental spiral tool like the 50901 or the IC4000, but 

you have some other way of determining groove twist, you do not need 
GSPIRAL. Just enter the spiral data manually, making use of the Interpolate 
button as described in section 6.2.1. 

 
To get a feel for how spiral corrections work, run GTILT PLUS, load the file 
VSIMPLE.GTL, and look at the plot of Cumulative Displacement in the A and B 
directions which is displayed automatically as soon as the file is loaded. As you can see, 
the inclinometer readings indicate a linearly increasing displacement in the A direction 
for set 2 of VSIMPLE, and a similar displacement in the B direction for set 3. To keep 
things simple, all readings in set 1 are zero. 
 
Select Edit/Spiral... to view the spiral data used in the VSIMPLE file. Notice that in this 
instance the cumulative twist shown increases linearly with depth, by ten degrees every 
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2 ft. The grooves are therefore in the shape of a right-handed helix, making one 
complete clockwise turn from the top to the bottom of the casing. 
 
Before proceeding, you may find it a useful exercise to make a sketch of what you think 
the spiral-corrected Cumulative Deflection, Incremental Deflection, and Absolute 
Position plots for set 2 and set 3 should look like. Remember that set 1 is a null set, set 
2 shows a linearly increasing displacement in the A direction only, and set 3 shows a 
linearly increasing displacement in the B direction only. 
 
To see how spiral correction affects the plot, select Set/Spiral Correction, and the true 
corkscrew-like nature of the VSIMPLE file is revealed. Do remember, however, that this 
represents a very extreme case, and the effect of spiral corrections in real inclinometers 
is usually far less obvious. 
 
6.2.3 Using GSPIRAL 
 
Run GSPIRAL.EXE by choosing Run and then navigating to the GSPIRAL.EXE file. 
Choose the Read RPP File option from the File menu and load SPIRAL1.RPP. Choose 
the Main Header option from the EDIT menu to see the header information from the 
RPP file. 
 
It is important to enter the correct Probe Sensitivity value. GSPIRAL defaults to a value 
of 60, i.e. it assumes that the instrument reads directly in minutes of arc. Invoke the 
Subheader option from the EDIT menu. The subheader screen appears. Recordkeeping 
is the main purpose of this screen, as GSPIRAL needs only a single set of Spiral data. 
Press ESC to get into the Spiral Readings editor. This is where you would have entered 
the Spiral tool readings manually if the RPP file had not been available. The depth 
increments are always five feet or 1.5 m or 1.0 m, there is no switching between sets 
because there is only one set of Spiral data, and there is no checksum histogram 
because it would be meaningless for Spiral data. Press ESC to get back to the Main 
Menu and use the Screen option of the GRAPHICS menu to see how the grooves twist 
with depth. A cumulative clockwise twist of ten degrees at a particular depth means that 
the azimuth of the A groove at that depth is ten degrees greater than the azimuth of the 
A groove at the top of the casing. These twist plots may not be very useful in 
themselves, but they do make it easier to detect gross errors in the input of the spiral 
data. Hard copies of the plots can be made if you have a PostScript-capable printer or 
an HP Laserjet III or later. The GSPIRAL utility does not directly create plots on most 
inkjet-type printers. 
 
Before we save the spiral data in a form accessible to GTILT PLUS, it is important to go 
back to the Main Header and check that the program has inserted the correct digit 
corresponding to the number of directions in which Spiral Readings were taken. The 
number can vary from one to four and is determined by GSPIRAL whenever a screen  
plot is displayed. GSPIRAL makes the assumption that there is one unread direction for 
each unbroken column of zeroes in the Spiral Readings Editor. Checking this number is 
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an easy way to ensure that a stray digit has not caused GSPIRAL to assign an extra 
reading direction, which would give low answers for Cumulative Twist. If the number is 
not as it should be, change it to the correct value, but also go into the Spiral Readings 
editor and delete the spurious number(s) which caused the error, otherwise it will recur 
the next time the Screen option is selected. 
 
 
6.2.4 Moving Data from GSPIRAL into GTILT PLUS 
 
Now that we have entered the data and checked it, we need a way to get it into GTILT 
PLUS. This is accomplished via an .SPI file. Choose the Save As option from the FILE 
menu of GSPIRAL. A filespec will be presented for editing. Since you are creating a 
new file, press Alt-C to clear the edit field and type the name REAL.SPI, then press 
ENTER. When prompted File will be saved as..... Ok to continue?, be sure to press the 
Y key to confirm that the file is to be written. The file will be created in the current folder. 
Before you quit GSPIRAL, you may wish to choose the Print option to create a 
tabulation of spiral against depth which you can compare later with the Spiral Data 
editor in GTILT PLUS, but be aware that this will work only if a printer that accepts 
ASCII text is connected to LPT1. You can now Quit GSPIRAL. If you need to go back 
and review the spiral data again, you can always reload the .SPI file you have just 
created. The RPP file is no longer required. 
 
Start or switch back to the GTILT PLUS program again. Use File/Load to load 
REAL.GTL, which is an ordinary inclinometer file without Spiral data. Then use 
File/Import/SPI file to load REAL.SPI. If you now Save REAL.GTL, the Spiral data will 
be saved along with all the data from all the readings to date. You could try saving it to 
REAL1.GTL so as to retain REAL.GTL in its original form for the purposes of this 
demonstration.  
 
Choose Edit/Spiral... and compare what you see with the tabulation printed by 
GSPIRAL. Notice that the cumulative twist values have been interpolated to coincide 
with the position of the center of the probe for each reading. 
 
Close the Spiral data window and choose Set/Spiral Corrections to see the effect that 
spiral correction has on the calculated deflections. Remember that plots are not 
corrected for spiral unless this option is activated. Spiral-corrected plots are labeled as 
such. Uncorrected plots carry no special marking. 
 
6.2.5 Example of the Use of a Spiral Sensor 
 
This section gives instructions for the use of the GSPIRAL utility in conjunction with 
RST’s IC4000 Spiral Checking tool. These instructions assume that the IC4000 is being 
used in conjunction with inclinometer logger model INS 5.2, but the information is 
broadly applicable to other spiral checking equipment also, including Sinco’s Spiral 
Sensor Model 50901. 
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The IC4000 spiral tool has a 1.5 m wheelbase. In order to calculate spiral correctly, 
readings are required at 1.5 m intervals over the full depth of the casing. Each reading 
represents the amount of clockwise twist that has occurred over the corresponding 
depth interval in the casing. The amount of twist occurring over each 1.5 m interval is 
summed downwards from the top of the casing, to give the cumulative amount of twist 
at any given depth in the casing. This part of the data reduction is carried out using 
GSPIRAL. 
 
Once the reduced spiral data has been stored on disk in GSPIRAL's SPI format, it can 
be imported into GTILT PLUS and used to correct the corresponding inclinometer data 
for the effects of spiral. It should be noted that for casings less than 50 m deep, the 
effect on the inclinometer plot is usually negligible. 
 
The Importance of Probe Offset 
 
The value displayed on the readout when the upper and lower wheels are perfectly 
aligned is referred to as the spiral probe offset. It is very important that this offset value 
be checked and entered into the GSPIRAL Subheader screen. The probe offset is used 
in correcting every reading of the spiral survey; since errors accumulate with depth, the 
determination of the probe offset is the most critical part of the spiral survey. 
 
Measuring Probe Offset 
 
1/ Connect the IC4000 probe to the cable reel, the cable reel to the conditioner box, 

and the conditioner box to the inclinometer logger model INS 5.2. Note that in the 
case of the IC4000, the probe and conditioner box are a matched pair and must 
be used together. 

 
2/ Using the membrane keyboard on the logger, change the logger torpedo 

specification to GEOKON, Biaxial, 0.5 meter, and sine angle under "LOGGER 
UTILITIES\Set Torpedo Specifications. 

 
3/ Find a solid, level surface such as a concrete floor. Place the aluminum leveling 

blocks on the floor and lay the spiral probe on top of the leveling blocks so that it 
is supported by its wheels only. Be sure that the upper wheels for the top and 
bottom assemblies are on the same side of the probe, so  
that the alignment marks on the housing line up. 

 
4/ Level the aluminum blocks using the precision machine level and adjustment 

screws on each block. Once this is done, the upper and lower wheels are 
considered to be aligned. 

 
5/ Leave the probe where it is on the leveled blocks, and use the membrane 

keyboard on the INS 5.2 to display a reading, just as if you were logging an 
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inclinometer hole. (Log Borehole/site/borehole code/face A+ and depth of hole.) 
The reading on the A+ channel represents the zero offset of the probe. Its value 
is usually less than 30 counts, i.e. it lies in the range of -0030 to +0030, and it 
represents a measurement of the offset in hundredths of a degree. Record this 
value. 

 
6/ Let the INS 5.2 continue to display the reading, lift the probe, and turn it end for 

end so that the wheel assemblies are interchanged. Relevel the blocks if 
necessary. The logger display should now show about the same offset reading 
as before. Record this value. Take the average of this and the value recorded in 
5/ and make note of it as the zero offset of the probe. This value will usually be in 
the range -30 to +30. 

 
7/ If you will not be making a spiral survey immediately, you may wish to reset the 

logger's torpedo specification to configure it for inclinometer readings. Depending 
on the type of probe in use, this might be LOGGER UTILITIES\Set Torpedo 
Specifications\RST BIAX, Biaxial, 0.5 meter, meters. 

 
Taking a Spiral Survey 
 
8/ Insert the spiral tool into the casing, taking care to place the upper wheels of 

each wheel assembly in the same groove (the A+ groove is suggested). Carefully 
lower the spiral tool to the bottom of the casing and lift it up to the next cable 
mark which represents a multiple of 1.5 m. The maximum depth will be about 1 m 
less than the maximum depth of inclinometer readings. 

 
9/ Set up the logger as per the depth of hole indicated by the cable marks. Let us 

assume the indicated depth is 99 m. Take three readings with the probe in this 
position. (The logger will record them if they were at 99.0, 98.5, and 98.0 m.) 
Raise the probe 1.5 m and take three more readings. Continue until you reach 
1.5 m depth. At this depth, take four readings rather than three, so that the logger 
recognizes that the top of the casing has been reached. If any of the readings are 
outside the range of -0200 to +0200, suspect a problem such as imperfect 
groove tracking. 

 
10/ There is no need to reverse the probe and re-run the survey as is required when 

taking inclinometer data. However, if a problem is suspected, run a second 
survey with the upper wheels in the A- groove, and record it as face C. The 
results of the two surveys should be essentially the same. 

 
11/ If you will not be making another spiral survey immediately, you may wish to 

reset the logger's torpedo specification to configure it for inclinometer readings. 
Depending on the type of probe in use, this might be LOGGER UTILITIES\Set 
Torpedo Specifications\RST BIAX, Biaxial, 0.5 meter, meters. 
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Getting the Data into GSPIRAL 
 
12/ Using a serial cable connection, transfer the results of the survey to a PC using 

the UNI_DOWN program which is supplied with the logger. Store the information 
in a file with the extension .NUM, e.g. 5432.NUM. 

 
13/ Start GSPIRAL and use File/Import NUM File to import the .NUM file. As part of 

the importing process, GSPIRAL averages the readings in groups of three, so 
that only a single reading appears for 99, 97.5, 96 m and so on. The reading for 0 
m depth is ignored. 

 
14/ Before saving the data to disk or making any plots, be sure to enter the spiral tool 

offset (average of the values measured in steps 5 and 6) in the appropriate field 
on the GSPIRAL SubHeader. Remember to include the sign, if negative. You are 
now ready to create plots of cumulative and incremental twist versus depth, and 
by using File/Save As, you can create an .SPI file for use with GTILT PLUS, as 
described in section 6.2.4. 

 
Sample File 
 
15/ A sample of data in NUM format is supplied in the file 5432.NUM. 
 
 
6.3 Accelerometer Rotation Error 
 
This type of error often manifests itself as a rotation of the plot about the base of the 
inclinometer, so that a significant deflection appears to have built up by the time the plot 
reaches the surface, but there is no obvious shear plane. This type of error is usually 
associated with casings which have been installed at two degrees or more from vertical. 
 
According to the instrument manufacturers, it is difficult to align an accelerometer to 
better than about 0.5 degrees of azimuth, equivalent to about 0.010 radian. If a casing is 
installed with a significant tilt (say 3 degrees) in the B direction, the readings taken in 
the A direction are likely to suffer from accelerometer rotation errors, especially if the 
probe is subjected to rough handling, if the accelerometer mountings are adjusted for 
any reason, or if the same probe is not used for successive sets of readings. The 
problem shows up on the cumulative displacement plot in direction A as a divergence 
from the expected result. This divergence takes the same shape (but not necessarily 
the same sign) as the absolute position plot in the B direction. 
 
The B direction CD plot can similarly be affected by changes in the alignment of the B 
accelerometer if the casing is out of vertical in the A direction. 
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The error is caused by the combination of a small change (perhaps 0.5 degrees or less) 
in the accelerometer azimuth relative to the wheels, together with a significant tilt of the 
casing in the B direction. Let us assume the casing was installed perfectly straight, but 
with a four-degree tilt (from the bottom up) in the B direction. We will also assume that 
the A direction accelerometer was in perfect alignment with the A grooves for the first 
set readings. A different instrument was then substituted for the first. The A direction 
accelerometer in the new instrument is aligned 0.5 degrees clockwise from the A 
grooves when it is run in the casing. 
 
Every reading in the A direction in the second set of data will exceed the corresponding 
reading in the first set by an amount which is equal to the Sine of 0.5 degrees times the 
value of the reading at the same depth in the B0 direction. Every reading in the A180 
direction in the second set of data will be less than the corresponding reading in the first 
set by that same amount. When differences are taken during the normal inclinometer 
calculation, the differences do not cancel out. The effect will be to apply an apparent 
uniform tilt in the A0 direction to the cumulative displacement plot. 
 
For the example quoted above, the error will accumulate to reach a value of Sine 0.5 
degrees times Sine 4 degrees times the total depth over which readings were taken. In 
round figures, for a 50 m casing, this amounts to an accumulated error of  

0.01 x 0.08 x 50 m = 40 mm 
 
To have GTILT PLUS apply a correction for this accelerometer rotation error, use 
Edit/Subheader to display the subheader information for the set of readings to be 
corrected. In the field marked Corrections in the center of the window, add the entry 
ROTA=.009, with no spaces. This tells the program to assume that the A direction 
accelerometer is rotated clockwise from the ideal position by .009 radians. Note that 
entering this correction leaves the readings themselves unchanged, and you can 
change your mind at any time regarding the magnitude of the correction. To discard the 
correction completely, just delete the entry. 
 
If you need to correct both the A and B directions, enter both items in the corrections 
field. Their order is not important. 
 
 
6.4 Bias Shift Error 
 
This type of error is less common than the accelerometer rotation error described 
above, and usually affects only a single dataset. If the zero reading of the A or B 
accelerometer should shift by, say, up to 100 divisions between one set of readings and 
another set taken a few days later, this does not generate any requirement for a 
correction because the normal procedure of taking two passes through the casing, with 
the toolface in the A0 and A180 directions, compensates for the change. 
 



Page 6-10 GTILT USER’S MANUAL Version 3 
 
However, it is possible for bias shift to occur during the course of a single dataset.  
Usually the shift occurs when the probe is removed from the casing after the first pass, 
or when it is turned and reinserted for the second pass, or is bumped on the bottom of 
the casing when it is lowered for the second pass. It can also occur if the probe is laid 
down horizontally between the first and second passes, especially if the power is turned 
off.  Best practice after the first pass is to remove the probe carefully, keeping the power 
on and not letting the wheels snap out abruptly. Keep the probe vertical while 
reorienting it for the second pass, reinsert it carefully without jerking, and lower it 
carefully without bumping it on the bottom of the casing. Between the first and the 
second pass, the probe should be out of the casing for only a few seconds.  
 
 If the shift occurs during the course of the first or second pass of the casing, it will 
generally manifest itself as a sudden change in the checksum, starting at a certain 
depth in the casing. This will show up as a shift in one of the checksum plots on the 
right side of the readings editor window. The effect on the individual readings is more 
easily seen by displaying differences from an earlier dataset. This is done using the 
option button labeled “changes from previous”.  If you can determine what shift occurred 
and when it occurred, you can correct the raw readings by subtracting the amount of the 
shift from the readings affected. However, if the shift occurs gradually, over several 
depth intervals, you will probably need to discard the affected dataset.  
 
If the shift is found to have occurred between the first and second pass, correction may 
be relatively simple. If there are several inclinometers at the site, and the reading times 
have been recorded, it may even be possible to determine the amount of the shift based 
on the change in the mean checksum between datasets taken on other casings, earlier 
and later on the same day. The required zero shift correction will be the number to be 
added to the average checksum of the suspect set to make it equal to the average 
checksum of the set taken immediately afterwards the same day. 
 
 
6.4.1 Shortcut for Bias Shift and Accelerometer Rotation Corrections 
 
Entering a correction string such as ROTA=-0.008 or ZB=12 and then closing the 
SubHeader window and refreshing the plot to view the effect can be a laborious 
process. You can test both types of correction more rapidly by using the buttons on the 
right side of the SubHeader window. For example, instead of entering ROTA=-0.008 in 
the corrections field, select the RotA option button, then click the button marked -0.001 
eight times, viewing the effect on the plot as you change the correction. You may want 
to move most of the SubHeader window off the left of the screen to get a better view. 
Each click adds a further adjustment to the plot, leaving also the earlier plots for 
comparison. When the plot gets too crowded, click the Refresh button to clean it up.  
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6.4.2 Example of Bias Shift Error 
 
Let us assume that we have taken four sets of readings of a casing called SI-1 (this is 
just a theoretical example, no such file is provided). The average checksums (according 
to notations at the base of the Checksum Histogram display, accessed under 
Edit/Readings) were 12, 14, 14, and 32. The plotted data shows no movement, except 
that the fourth set indicates a cumulative displacement which increases linearly from 
zero at the bottom of the casing to a significant value at the ground surface. A bias shift 
which may have occurred between the A0 and A180 readings is suspected. In this 
situation it will probably be found that if a correction of minus 19 units is applied to the 
readings in the fourth set in the A direction, the fourth set will become consistent with 
the other three. To apply this correction, use Edit/Subheader to display the subheader 
information for the dataset for which the correction is to be applied. In the field marked 
Corrections, add the entry ZA=-19 with no spaces. Note that the numbers representing 
the original readings are left unchanged. If you subsequently decide that the correction 
should be -29, just change the -19 to -29. 
 
Bias shift correction is relatively rare, and is justified in less than one percent of 
datasets. Do not use zero shift correction unless you are sure that your problem is not 
caused by accelerometer rotation, which was described in an earlier section. 
 
 
 
6.5 Distinguishing between Accelerometer Rotation and Bias Shift 
 
6.5.1 Reasons to Suspect Accelerometer Rotation Error 
 
1/ You are using more than one probe, or the probe has been overhauled or 

subjected to rough handling between datasets. 
 
2/ The casing has a tilt of more than one degree (about 2 percent), in the direction 

perpendicular to that in which the error shows up on the plots. 
 
3/ The shape of the deviation from the expected cumulative displacement plot is 

similar to the shape of the deviation from vertical of the absolute position plot in 
the orthogonal direction. For example, the shape of the deviation from the 
expected CD plot in direction A is similar to the shape of the deviation from 
vertical of the absolute position plot in direction B. 

 
4/ Several inclinometers are affected at the same time, and worst affected are the 

ones that have the most casing tilt. 
 
6.5.2 Reasons to Suspect Bias Shift Error 
 
1/ You are using the same probe for all datasets. 
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2/ The probe was handled roughly, turned off and/or laid down horizontally between 

the first and second pass. 
 
3/ The checksum histogram for the problem dataset looks normal, but the mean 

checksum differs from that calculated for earlier and later datasets. 
 
4/ The cumulative displacement plot deviates from its expected shape by an 

amount which changes at a constant rate with depth. 
 
 
6.5.3 Sign Conventions 
 
The adjustment which is applied to the plot as a result of the correction entry ZA=10 is 
to increase the reading in the A0 direction by 10 divisions. This can be regarded as 
compensating for the probe having undergone a zero shift of +10 divisions after the A0 
traverse and prior to taking the A180 readings. 
 
ROTA=.010 assumes that the A accelerometer has suffered a relative clockwise 
rotation of .010 radians since the initial set of readings. It applies a correction which 
brings the effective accelerometer azimuth back to its original direction. 
 
6.5.4 Footnotes on Plots 
 
Each set of data which has undergone zero shift or rotation correction is denoted by an 
asterisk next to the corresponding entry in the legend. A footnote is added at the base 
of the plot. It is impractical to show on the plot all the details of the corrections applied. 
This information can be printed on a separate sheet, using the appropriate option under 
File/Tabulate. 
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6.6 Telescoping Casing 
 
Where significant settlement is expected, e.g. in a landfill, inclinometer casings are 
usually installed with telescoping joints in order to prevent the casing from being 
crushed longitudinally. This not only extends the life of the casing, but also may allow 
settlements to be monitored at various depths in the fill. 
 
Dunnicliff (1988, page 265) mentions two methods of data collection and processing for 
this situation.  
 
The first method involves always taking inclinometer readings at the same locations 
within the casing, by recognizing the "bump" as the wheels pass over the telescoping 
joints and then taking the reading at a given fixed distance from the nearest coupling. 
Settlements are determined using a mechanical probe extensometer which hooks on to 
the telescoping joints and the settlement data is used in processing. 
 
To implement the second method, readings are taken at uniform depth intervals as 
usual. Settlements are measured as in the first method. Because the readings are no 
longer being taken at the same locations in the casing, a computer is used to interpolate 
between the readings which straddle the ideal measuring point to produce the best 
estimate of the reading that would have been obtained at that location.  
 
As mentioned by Dunnicliff, the first method is more accurate, because in the second 
method the wheels may sometimes rest on a corner at the end of a section of casing, 
causing poor repeatability. However, the second method requires much less effort in the 
field. 
 
The second method is the one implemented in GTILT PLUS, because it has the 
advantage that it can be applied in situations where there were originally no plans to 
allow for the effect of settlement on the inclinometer data. It is suggested that the effect 
of the disadvantage pointed out by Dunnicliff can be reduced by taking care not to take 
readings directly on a "bump" caused by a casing joint. 
 
The following notes describe how to compensate for casing compression using GTILT 
PLUS. 
 
1/ The method assumes that, as usual, readings have been taken at a constant 

depth increment, as measured from a reference at or near the top of the casing. 
 
2/ The correction is based on measurements of settlement at various depths in the 

casing. The depth to each casing joint, or perhaps to a magnetic marker, is 
measured at the same time as each set of inclinometer readings is taken. 
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3/ The cumulative amount of compression that has occurred at each joint (since the 

first set of readings) is plotted against depth. The plot axes should be set up as if 
the joints remained at their original depths with respect to the top of casing. 

 
4/ The overall settlement profile for each set is approximated by a series of 

coordinates in the form r1,s1,r2,s2,r3,s3.....up to a maximum of r9,s9, where rn is 
the reading number and sn is the cumulative amount of casing compression 
which has occurred between that part of the casing and the top of the casing. 
For example, if readings had been taken at 2 ft intervals starting at 4 ft below top 
of casing, and it was known that 9.2 inches of casing compression had occurred 
between the joint at 50 ft and the top of the casing, then this would be expressed 
as 24,.77. This location would correspond to the 24th reading, numbered starting 
from the top, and to a casing compression of .77 ft. 

 
5/ The list of compression benchmarks is combined in a comma-delineated series 

and placed in the upper remarks field in the subheader of the set to which it 
refers. It is assumed that there is no casing compression corresponding to the 
uppermost reading, and that the amount of compression remains constant 
beyond the last value given. 

 
In the example described above, if the compression profile was essentially linear 
from the top of the casing down to the 50 ft level, and there was no settlement 
(i.e. no change in compression) below 50 ft, the profile could be fully described 
simply by entering the values 24,.77 in the upper remarks field. 
If four intermediate points were desired, the entry in the upper remarks field 
would take the form  

 
11,.44,  24,.77,  28,.81,  34,.88 

 
The spaces are optional but the commas are required. Do not use more than 
nine pairs of coordinates, and note that in the above example, if there were 62 
readings per set, a leading 1,0, and a trailing ,62,.88 are implicit. 

 
6/ In order to guard against accidental activation of the casing compression 

calculation, the string CMP! must be placed in the Corrections field of each set 
for which the calculation is desired. An example of this is shown in file 
SETTLE1.GTL. 

 
7/ While you are entering the compression information, be sure that the Depth 

Correction option on the Options menu is set to Depth Corrections - No. When 
the desired correction values and the CMP! string have been entered, be sure to 
save the file before proceeding. 

 
Note that the CMP! is changed to CMQ! when the corrections are actually 
applied. This is to prevent the generation of garbage by inadvertently applying 
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the correction twice to the same data. Do not manually change the CMQ! back to 
CMP!, as you will likely end up producing meaningless results. 

 
Unlike any other correction in GTILT or GTILT PLUS, the application of the depth 
correction overwrites original readings in RAM. Once the depth correction has 
been applied, the original readings are no longer present in RAM, and the data in 
RAM should therefore not be written to disk. (Dire warnings appear if such a save 
is attempted.) You must therefore save your data before viewing the effect of a 
depth correction. 

 
8/ Once the data has been safely saved to disk, apply depth corrections by 

selecting Set/Depth Corrections. The correction will be applied to every set that 
has the CMP! entry and the list of correction values in its subheader. All screen 
and hard-copy plots and printouts will incorporate the correction. 

 
9/ Note that from this point on, the values tabulated in the readings editor will be the 

corrected values, and will no longer correspond to the field readings. To view the 
field readings, or before adding any new data sets, reload the file from disk. 

 
10/ It should be noted that the corrections are applied only to calculated 

displacements, and not to depths or elevations. For example, the horizontal 
displacement of the 50 ft joint will always be shown at the same vertical location, 
regardless of any change in its true depth or elevation. 

 
 
6.6.1 Further Illustration of How the Casing Compression Correction Works 
 
Consider a casing in which nine readings were originally taken at 0.5 m intervals. The 
readings were taken at locations Q, R, S, T, U, V, W, X and Y, and the readings are 
numbered 1 to 9 starting from the top. (The readings can of course be taken starting at 
number 9, and this would be usual.) At point Y, elevation 101.0, where reading 9 was 
taken, there has been no settlement. At point Q, where reading 1 was taken, there has 
been 0.25 m of settlement. 
 
Clearly there is no need to correct reading 1 for position, because it is taken exactly at 
point Q, in the same position in the casing as it was originally. However, reading 9 is 
taken 0.25 m below its original casing position of point Y. To get the best possible 
estimate of the current inclination at correct reading 9 for position, we would therefore 
use the average of readings 8 and 9 instead of using reading 9 directly. Similarly, the 
current inclination of the casing at points R through X are calculated by interpolation 
from readings 1 through 9. 
 
Finding the current casing inclination at points Q through Y is not the whole story. Note 
that the distance between points Q and Y has reduced from 4.0 m to 3.75 m. If the 
casing were to settle vertically and uniformly, the inclination at each of the points Q 
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through Y would be expected to increase slightly, in proportion to the amount of casing 
compression that has occurred.  Since we are trying to calculate the change in 
horizontal position of a number of points on the casing, we must adjust each reading by 
an amount equal to the initial absolute inclination at that location times the longitudinal 
strain (i.e. compression) in that portion of the casing. 
 
 
6.6.2 A Simple Example using Depth Corrections 
 
The file FILLA.GTL is a synthesized file which illustrates two different ways of managing 
the depth correction. Set 1 of FILLA.GTL represents the initial set of readings and 
therefore requires no correction for settlement/casing compression. Note that Set 1 
shows a constant curvature in the A+ reading only. For simplicity, the other readings are 
set to zero. Sets 2 and 3 represent readings taken after a total of one meter of 
settlement has taken place in the upper 20m only, with no settlement at all in the lower 
10m, and no horizontal movement. 
 
Set 2 represents what the post-settlement readings might have been if they had been 
taken in the normal way, measuring all depths from the top of the casing using the cable 
marks. Note that the bottom two readings are equal, because they would both have 
been taken just off the bottom of the casing. This is OK because the depth correction 
will replace these values with corrected ones calculated from readings taken higher up. 
 
Because of the constant curvature in A+, and the increasing depth discrepancies in the 
lower part of the casing, the change in readings increases from zero at reading 1 to +40 
units at reading 40. Below reading 40 (20.5 m depth) the change in readings is 
constant, as there is no settlement in the bottom 10m. 
 
The correction string for set 2 is 1,0.0,40,1.0,60,1.0 
 
Set 3 represents the readings after settlement if the probe had,  for the deepest reading 
only, been lowered to the same point in the casing as for the corresponding reading in 
set 1. The probe would then have been raised by the normal 0.5 m interval for the rest 
of the readings. The top of the casing would of course have been reached before the 
desired number of readings had been taken. The final two readings would therefore 
have been taken as high up in the casing as practicable. This is OK, because the depth 
correction will replace these readings with values calculated from readings taken lower 
down. 
 
Because of the constant curvature in A+, and the increasing depth discrepancies in the 
upper part of the casing, the magnitude of the change in readings increases from zero 
for the bottom 10m to -40 near the top of the casing. Note that the reading at the very 
top does not change because the last 2 or 3 readings would have been taken at the 
highest practicable reading point. 
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The correction string for set 3 is 1,-1.0,40,0.0,60,0.0 
 
It is suggested you load FILLA.GTL into GTILT PLUS and view the corrected and 
uncorrected versions of the plots. 
 
6.6.3 If you Extend Telescoping Casing 
 
If you add casing to an installation where you are applying depth corrections, you will 
need to go back and adjust the depth correction string in each earlier set where a 
correction is being applied. For example, if you add 3m of casing, you will normally be 
inserting 6 additional readings at the top. For example, the correction string for set 2 of 
FILLA described above would change to 
 

1,0.0,7,0.0,46,1.0,66,1.0 
 
 
6.7 Other Uses of Casing Compression Corrections 
 
Two additional uses for the compression correction approach have been suggested, 
notably by Philippe Fayad/Shawkat Ali of Woodward-Clyde Consultants and by Erik 
Mikkelsen of Landslide Technology. 
 
6.7.1 Landfill over a Critical Foundation 
 
The first example concerns a situation where small deflections in the foundation of a 
landfill were more important to the designer than larger deflections within the garbage 
above. Very large settlements were taking place within the garbage, and little or no 
settlement within the foundation materials. Readings were taken at a constant depth 
interval, in this case counting up from the bottom of the casing. Because the casing was 
getting shorter with time, the last few readings were all taken at a point near the top of 
the casing. The next paragraph tells why this does not produce an error. 
 
Although the reading method differs from that described in section 6.6, the resulting 
readings can still be corrected using GTILT PLUS. We just have to bear in mind that 
there is no depth error at the bottom reading, and the readings above are all taken 
higher in the casing than was the case in the initial set. This means that we have to 
apply a negative depth correction to all but the bottom reading. At the topmost reading 
the correction may amount to several times the probe wheelbase length. This means 
that the topmost readings do not figure in the calculations, because the program 
regards them as being above the top of the casing. The correction string would then 
look something like  
 

1,-7.22,25,-4.55,52,-0.31,62,0 
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6.7.2 Deep holes with different cables 
 
Very deep inclinometers which are read using different cables can produce noticeable 
errors due to slight differences in cable length. This is exacerbated by inconsistent 
elastic lengthening of the cables, and by curvature of the wellbore. This effect can be 
countered by always using the same cable, or by having a known depth correction 
string. A cable that was too short would have a negative depth correction, (e.g. 1,0,20,-
0.1,40,-0.17 etc.), because the readings it produces have been taken too high up in the 
casing. 
 
6.7.3 Depth Reference Error 
 
If, by mistake, a casing is surveyed starting at the wrong reference point, e.g. 2,4,6.. ft 
where the initial survey was at 1,3,5.., the ideal solution is to resurvey the casing. If this 
is not possible, the next-best solution would be to apply a uniform compression 
correction of 1 ft over the full length of the casing. The correction string would be 
something like 1, 1, 52, 1. This type of error can be caused by inadvertently reading the 
cable marks relative to the top of casing when previous surveys have used the top of 
the cable clamp, for example. 
 
With most inclinometer systems, the cable marks correspond to the distance measured 
from the midpoint of the probe wheelbase, and this is the default assumption made in 
Gtilt. Some systems measure instead from the upper wheels. 
 
There are other possible applications for this type of correction. In developing them, 
remember that a positive correction is applied to readings that are taken too low down, 
and a negative correction to readings taken too high up. Remember also that in 
settlement situations you will usually have a zero or negative correction for the top 
reading and a zero or positive correction for the bottom reading. A large negative 
correction at the top reading means that the topmost few readings do not enter into the 
calculation. 
 
If a positive correction occurs at the top reading or a negative correction at the bottom 
reading, this means that the program is forced to extrapolate beyond the end of the 
available data. In this situation, it assumes that the reading is the same as the closest 
available value. This is equivalent to assuming the casing continues in a straight line.  
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Downloading from Soil Instruments Limited Model 1022 or 1124 Logger 
 
From the File menu of GTILT PLUS, run the TiltComm utility.  
 
If necessary, press Logger/Readout and select Soil Instruments Model 1022. 
 
Set the appropriate serial port number for TiltComm and connect the logger to that port 
using the serial cable provided with the logger. 
 
Using the drive and folder list boxes in the upper right of the window, select a target 
folder in which the data is to be placed, then press Continue. 
 

Power up the logger using 9600,N,8,1 
 

Use the logger’s DUMP function to send the data. 
 
 
When finished, quit TiltComm and power down the logger. 
 
All of the data is stored in one file named for today’s date, in the format 
YYMMDDaa.102. If this file already exists, the next available root name ending in ab, 
ac, ad etc. is selected automatically. 
 
Inclinometer datasets in the .102 file can be imported into GTILT PLUS, version 2.15 or 
later. Be sure to load any existing .GTL file for each inclinometer before selecting 
File/Import/102 File. After selecting the .102 file, choose which dataset you want to 
import from the list provided. If any of the datasets are already present in the loaded 
.GTL file, they are flagged with the notation Set 1, Set 2 etc. so that you can avoid 
duplication. 
 
If you are using a Model 1124 logger to record spiral, you should opt to split the data 
into separate .TWI files. You can then load the appropriate .GTL file into GTILT and use 
File/Import/TWI File to incorporate the spiral data. 
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Downloading from Geokon GK-603 Inclinometer Data Logger 
 
From the File menu of GTILT PLUS, run the TiltComm utility.  
 
 
 
If necessary, press Logger/Readout and select Geokon GK-603. 
 
Set the appropriate serial port number for TiltComm and connect the logger to that port 
using the serial cable provided with the logger. 
 
Using the drive and folder list boxes in the upper right of the window, select a target 
folder in which the data is to be placed, then press Continue. 
 

From the GK-603 logger’s Main Menu:- 
 

Transmit/Receive 
 

Send Data File 
 

<all>    (Or choose a single file) 
 
 
It is simplest to use <all> rather than choosing single files. 
 
When finished, quit TiltComm and power down the logger. 
 
All of the data is stored in one file named for today’s date, in the format 
YYMMDDaa.GKS. If this file already exists, the next available root name ending in ab, 
ac, ad etc. is selected automatically. 
 
The .GKS file can be imported into GTILT PLUS, version 2.15 or later. Be sure to load 
any existing .GTL file for each inclinometer before selecting File/Import/GKN/GKS File. 
After selecting the .GKS file, choose which dataset you want to import from the list 
provided. If any of the datasets are already present in the loaded .GTL file, they are 
flagged with the notation “Set 1”, “Set 2” etc. so that you can avoid duplication. 
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Downloading from the Roctest/Telemac Acculog-X or -iX 
 
From the File menu of GTILT or GTILT PLUS, run the TiltComm utility.  
 
If necessary, press Logger/Readout and select Roctest/Telemac Acculog-X. 
 
In TiltComm, set the serial port number to which you will be attaching the logger but do 
not connect the logger yet. 
 
Using the drive and folder list boxes in the upper right of the window, select a target 
folder in which the data is to be placed, then press Continue. 
 
On the Backlog logger:- 
 

Power up the logger and wait for its main menu to appear. 
 

Then connect the logger to the appropriate serial port on the PC. 
 

All of the data in the logger will be transferred. 
 
All of the data is stored in one file named for today’s date, in the format 
YYMMDDaa.ALX. If this file already exists, the next available root name ending in ab, 
ac, ad etc. is selected automatically. Once the transfer is complete, you are given the 
option to split the data into separate .RPP files. Splitting is not normally necessary, and 
can be done later if required.  So decline the Split and Quit TiltComm. 
 
The .ALX file can be imported into GTILT or GTILT PLUS, version 2.15 or later. Be sure 
to load any existing .GTL file for each inclinometer before selecting File/Import/ALX File. 
After selecting the .ALX file, choose which dataset you want to import from the list 
provided. If any of the datasets are already present in the loaded .GTL file, they are 
flagged with the notation “Set 1”, “Set 2” etc. so that you can avoid duplication. 
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Downloading from Sisgeo NADIR or Phoenix Geometrix GEO-LOG 
 
From the File menu of GTILT PLUS, run the TiltComm utility.  
 
If necessary, press Logger/Readout and select Sisgeo NADIR 
 
Set the appropriate serial port number for TiltComm and connect the logger to that port 
using the serial cable provided with the logger. 
 
Using the drive and folder list boxes in the upper right of the window, select a target 
folder in which the data is to be placed, then press Continue. 
 

From the NADIR logger’s Main Menu:- 
 

Transmit Data 
 

Send Data File 
 

Then choose a file to send. The file will be named after the tube name and the dataset 
number. For example, tube S9901, set 3 will be written to S9901.3. 
 
When all desired files have been sent, quit TiltComm and power down the logger. 
 
The files can be imported into GTILT PLUS, version 2.15 or later. Be sure to load any 
existing .GTL file for each inclinometer before selecting File/Import/NADIR file. Once 
you are satisfied that the correct file has been imported, use File/Save or File/Save As 
to save an updated version of the GTL file which includes the new data. 
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Using TiltComm to transfer data from the Digitilt® DataMate 
(See recommendation below about DMI.) 
 
From the File menu of GTILT® PLUS, run the TiltComm utility.  
 
If necessary, press Logger/Readout and select Sinco DataMate. 
 
Set the appropriate serial port number for TiltComm to use and connect that port to the 
DataMate’s I/O port using the serial cable provided with the DataMate. 
 
Using the drive and folder list boxes in the upper right of the window, select a target 
folder in which the data is to be placed, then press Continue. The rest of the transfer is 
controlled from the DataMate keypad: 
 

Power up the DataMate. 
 

Wait for the Sinco copyright message to clear. 
 
Choose Datasets, Print  (on newer DataMates, choose Surveys, Print). 
 
Change the baud rate to 4800 if necessary. 
 
Scroll down to the first dataset to be transferred, then press the Enter pad. 

 
 
When finished, quit TiltComm and power down the DataMate. 
 
Each dataset is written to its own .RPP file, ready for importing into GTILT® or GTILT® 
PLUS. 
 
 
Important recommendation: As of January 2003, an alternative interface designed 
specifically for use with the DataMate is provided by the DMI utility, which can be found 
in the DMI folder on the Gtilt Plus program CD. The CD also contains a user manual for 
DMI. For transferring data from the DataMate, DMI is simpler and faster to use than 
TiltComm. It downloads all datasets with a single click, it speeds up subsequent 
importing of the data into Gtilt Plus, and it can also be used to set up installations in the 
DataMate in preparation for taking inclinometer readings. It even allows you to review 
the quality of the transferred data and remove junk datasets before the data is saved. 
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Downloading RST/Geotechnical Instruments Model INS 5.2 Data Logger 
 
From the File menu of GTILT or GTILT PLUS, run the TiltComm utility.  
 
If necessary, press Logger/Readout and select  
 RST/Geotechnical Instruments Model INS 5.2 
 
Set the appropriate serial port number for TiltComm and connect the logger to that port 
using the serial cable provided with the logger. Usually the logger is already set for 2400 
baud, no parity, 8 bit word length, no handshaking, and one stop bit. 
 
Using the drive and folder list boxes in the upper right of the window, select a target 
folder in which the data is to be placed, then press Continue. 
 
Power up the Model INS 5.2 logger, then:- 
 

Press 4 to select Communications. 
 

Press 2 twice to set ASCII file transfer format.  
Some units call this “Previous Transfer Format (MK3 IN system). 
You can generally skip this step in future, as it will already be set. 

 
Press 3 to select Direct Communications. 

 
Send the data using one of the following: 

2-All Files for One Borehole 
3-All Files for One Site 
4-Entire Memory 

 
You will need to press 5 on the logger twice to confirm the download when 
prompted. Each dataset is listed on the screen as it is transferred. 

 
You can download multiple boreholes or sites in one session, but the simplest option is 
to download the entire memory. When finished, quit TiltComm and power down the 
logger. 
 
All of the data is stored in one file named for today’s date, in the format 
YYMMDDaa.DTY. If this file already exists, the next available root name ending in ab, 
ac, ad etc. is selected automatically. 
 
The .DTY file can be imported into GTILT or GTILT PLUS, version 2.16 or later. Be sure 
to load any existing .GTL file for each inclinometer before selecting File/Import/DT and 
DTY Data. After selecting the .DTY file, choose which dataset you want to import from 
the list provided. If any of the datasets are already present in the loaded .GTL file, they 
are flagged with the notation “Set 1”, “Set 2” etc. to help you avoid duplication. 
 



 

 

 
 
 


